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Resumen

O R apresenta uma gama de ferramentas como testes paramétricos e nao
parameétricos, andlise de regressdo linear e ndo linear, analises de sobrevivéncia,
analises multivariadas, producéo grafica, dentre outros. E importante mencionar que o
R ndo é simplesmente um programa estatistico. No presente capitulo, apresentamos
aspectos introdutorios ao ambiente R, como instalacdo do programa, carregamento e
instalacdo de pacotes. Os comandos a serem executados no R estdo sendo
apresentados com a cor azul.
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1. Introducdo

A estatistica pode ser definida como a matematica aplicada aos dados de observacdo
[1]. Através da Estatistica conseguimos descri¢des claras, sintéticas e objetivas [2].

Em uma perspectiva entomoldgica, a estatistica € uma condicdo essencial pois
trabalha com métodos cientificos para coleta, organizacéo, resumo e apresentacao de
dados e também para obtencéo de conclusdes e a tomada de decisdes.

As dificuldades enfrentadas por estudantes e pesquisadores entomologistas que
precisam fazer uso da inferéncia estatistica parecem decorrer da falta de livros
didaticos, escritos em linguagem a eles adequada, livre de algebrismos usualmente
empregados pelos estatisticos matematicos. Para sanar essa lacuna, o presente livro
tem como objetivo divulgar comandos basicos para analise descritiva, analise de
variancia e andlise de deviance com dados entomoldgicos em linguagem R. A
estratégia utilizada para alcancar esse objetivo consistiu na preparacao de scripts com
linguagem simples e com exemplos entomologicos.

O programa estatistico que tem mais auxiliado em analises estatisticas de dados
biolégicos é aquela baseada no ambiente R, que é uma linguagem de programacao
estatistica, de acesso aberto, e que vem se tornando cada vez mais popular.

Em virtude de suas caracteristicas, o R Development Core Team classifica como
ambiente R [3].

O R é um software livre para andlise de dados. Isto significa que ele pode ser utilizado,
copiado, distribuido, alterado e melhorado de forma livre. Foi desenvolvido em 1996,
com os professores de estatistica Ross Ihaka e Robert Gentleman, eles trabalhavam e
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eram colegas no departamento de estatistica na Universidade de Auckland, os dois
compartilhavam o interesse por estatistica computacional e viram a necessidade de
um melhor ambiente de software para o laboratério da éarea. Entdo, eles
desenvolveram uma nova linguagem computacional, similar a linguagem S [3].

O software € um ambiente colaborativo internacional de desenvolvimento e pesquisa
mantido formalmente pela R Foundation, disponibiliza uma ampla variedade de
técnicas estatisticas e graficas, incluindo modelagem linear e nédo linear, testes
estatisticos classicos, analise de séries temporais, classificacdo, agrupamento e
outras. Vocé pode “baixa-lo" da Internet, de forma gratuita (www.r-project.org). Um
conjunto basico de pacotes vem embutido na instalacdo do R, com muitos outros
disponiveis na rede de distribuicdo do R (CRAN). Pesquisas e levantamentos com
profissionais da area mostram que a popularidade do R aumentou substancialmente
nos ultimos anos [4]. Em 2017, o R ja possui mais de 10.000 pacotes disponiveis [5].
Um pacote € um conjunto de fungdes que vocé consegue acessar em seus codigos,
bastando importa-lo. Existem pacotes para resolver varios problemas como construcéo
de gréficos, analise descritiva, andlise de variancia etc.

2. Motivos para utilizar o R

Todos os codigos séo abertos, reproduziveis e adaptaveis;

Compativel com Windows, Mac, Linux e etc;

Utilizado para criar outros softwares;

Empresas privadas e publicas estdo se atentando ao R;

Link com C, C++, Java entre outros;

Otima documentacéo (alteracées de versdes e help’s);

Comunidade académica disseminando conhecimento;

Altamente extensivel;

E continuamente suportado pela comunidade, com réapida correcdo de
bugs e adicdo de novas funcionalidades.

VVVVVYVVYY

3. Instalacdo do R

Cliqgue em CRAN;

Escolha o espelho de sua preferéncia (CRAN mirrors);
Cligue em Windows;

Cligue em base e salve o arquivo do R para Windows;
Depois é s6 executar 0 arquivo.

YVVVYY

4. Console do software “R”

R RGui (22-bit)
File Edit Packages Windows Help

= CIET =

I Untitled - R Editar = [
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5. Usando o R como um ambiente de desenvolvimento integrado (IDEs)

RStudio € uma interface integrada para gréficos e calculos estatisticos. Um
acessorio escrito na linguagem C++, esta disponivel em duas edi¢bes: RStudio
Desktop, que roda localmente como um aplicativo desktop padrédo; e RStudio
Server, que permite acessar o RStudio usando um navegador web.

RStudio - [w]
Fle Edit Code View Plots Session Build Debug Profile  Tools  Help
O - Opl - t i - Addins -

Environment  History  Connections

Files Plots Packages Help Viewer

Console  Terminal Jobs

Type 'license()" or "licence()' for distribution details.

R is a collaborative project with many contributors.

Type 'contributers()’ for more information and

'citation()' on how to cite R or R packages in publications.
| Type 'demo()' for some demos, 'help()' for on-Tline help, or

"help.start()" for an HTML browser interface to help.

Type 'q()' to quit R.

Tumrbemara Tanadad fram _/ onara 1

Para baixar o RStudio clique em:
https://www.rstudio.com/products/rstudio/download/ e escolha opg¢édo Rstudio
desktop.

6. Script

Para abrir e praticar no Rstudio com um novo script, v em:
» File > New File >R Script
Se preferir abrir um script que ja tenha salvo, va em:
» Open File> selecione o arquivo > Abrir
No script vocé pode digitar comandos a serem executados e também

comentéarios. Os comandos sdo escritos como no console e tudo que é escrito
apos # sao considerados apenas como comentarios.
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RStudio
File Edit Code View Plots Session Build Debug Profile Tools Help
N e b to file/function ~ Addins
New Project... |
Open File... Ctrl+0 Environme
Recent Files [Tt 1ou I&a - i_T"
Open Project... Global
Open Project in New Session... .
Recent Projects 4 Iat-l VO com
Import Dataset y ! :
para obt
Save Ctrl+S
O R é um programa que ocupa pouco espaco e memoria e geralmente roda
rapido, isso porque os pacotes vém na instalacao base, ou seja, configuracbes
minimas para funcionar. Para realizar tarefas mais complexas pode ser
necessario instalar pacotes adicionais (packages), esse é um dos grandes
beneficios do R, seu grande acervo de pacotes. Qualquer pessoa pode enviar
um pacote e todo codigo enviado esta disponivel na internet. Existe, porém, um
processo de avaliacdo que o cbdigo passa e certas normas rigidas devem ser
respeitadas sobre o formato do cdédigo, o manual do usuario e a forma de
atualizacdo do pacote.
RStudio
File  Edit Code View Plots  Session Build Debug Profile = Tools Help
S - CR 2’ - Go to file/function ~ Ac Install Packages...
Check for Package Updates...
@ Untitled1* Histor
Source on Save L S Version Control ' VimportC
1 Shell.. ironment
2 Terminal 4
Jobs » 3.Spee
Addins » _Jeed
Keyboard Shortcuts Help Alt+Shift+K Packa
Modify Keyboard Shortcuts... -0
Project Options...
Name
Global Options... B Lta
2:1 (Top Level) = R Script = Rhistory
| Bt_experime

Console  Terminal Jobs

| ™ . el
== Finura Grafic

Outra forma é, no lado direito da tela, clicar em:

» Packages>Install> digitar o nome do pacote e instalar.
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) Rstudio
! Edt  Code View  Plat session Builkd  Debug  Profile
o -0 - A Go to file/function - Addins ~
Console ~/ ) Environment  History  Connections  Tutorial
dld UTLdlllieE> UT UisLl Tduilca
J P L~ il s | * Import Dataset ~ .,!’
0.

"\ Global Environment =

Install Packages

Install from: 7' Configuring Repositories Environment is empty

Repository (CRAN) v i

| Files Plots Packages Help Viewer

Packages (separate multiple with space or commal:
ges (sep: L2 P ) 6l install @ Update

readx ] MName Description

renchl ibrary: User Library

readxlsb | i indli |

jessy/OneDrive/Documentos/Riwin-library/4.0 [Defaul ¥ ascertthat Easy Pre and Post Assertions
7)Install dependencies cellranger Translate Spreadsheet Cell Ranges to Rows and
Columns
cli Helpers for Developing Command Line Interfaces
Install Cancel crayon Colored Terminal Qutput
|

v g . digest Create Compact Hash Digests of R Objects
Digite 'a()' para sair do R. ellipsis Tools for Working with ...

7. Usando o0 R como um ambiente de desenvolvimento integrado (IDEs)

Para carregar um pacote dentro de um script, utilizamos a funcéo library()

ou require(), dentro do paréntese o nome do pacote que deverd ser
carregado.

£ Rstudio
File Edit Code View Plots Session Build Debug Tools Help
ol-l - B B 8| [(Acowiein Fv Addins -

@] Untitled1* x

. 7 [ [JSourceonSave & / ~
1 TlibraryChnp)
2 |

#reguire (ncome pacote)-Carregar um pacote

2:1 (Top Level) =

Console -/
wWarning message:

package ‘hnp’ was built under R version 3.2.5
> TibraryChnp)
-

8. Lendo um arquivo

Para ler um banco de dados utilize a fungéo read.table para fazer a importacdo
dos dados.

10
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A linha de comando exemplificada dados=read.table(file.choose(),h=T
direciona vocé a pasta que contém o seu banco de dados no ambiente R
(dados), a funcao para fazer a importacdo dos dados (read.table) e a fungéo para
escolher a pasta na qual seus dados estéo (file.choose).

RStudio
File Edit Code View Plots Session Build Debug Profile Tools Help

Ol -l - 3 3

Go to file/function ~ Addins -

@] Untitled1* =
. : = SourceonSave | QO /7~ | S Run | ®=| [ P Source ~

1 dados=read.table(file.choose(),h=T)

2

3

9. Visualizando um Plot

Para visualizar seus graficos, clique na aba plots na linha superior do console ou
na aba plots no lado direito, dessa maneira vocé pode usar a vassoura para
limpar ou zoom para aumentar o seu plot.

£ RStudio

File  Edit Code View | Plots | Session  Build Debug  Profile  Tools  Help

O - g - i Go to fileffunction = Addins =
@] Untitled1* ] Environment  History Connections  Tutorial
4
Source 4L S bl . Source ~ T “* Import Dataset ~ | &
1 I "} Global Environment =

Environment is empty

Files | Plots | Packages Help Viewer

= Export =

111 (Top Level) = R Script =

10. Customize seu Rstudio

Nessa opc¢do vocé pode alterar e personalizar o Rstudio de acordo com suas
preferéncias, por exemplo, modificar a fonte, o tamanho, a cor etc. Clique em:

» Tools> Global Options>
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) Rstudio
File Edit Ceode View Plots Session Build Debug  Teols Help
Ql-lc- H B Import Dataset »
] Untitled? Install Packages... — =
= Check for Package Updates... o
Al 1] [] Seurce on Save Q g = | Source =
1 Version Contrel 4
Shell...
Addins 4

Keyboard Shortcuts Help Alt+Shift+K
Modify Keyboard Shortcuts...

Project Optiens...

Global Options...

11. Buscando ajuda

Existem algumas maneiras para obter ajuda sobre o funcionamento de
comandos e pacotes. Por exemplo, clicando na aba Help ou digitando a linha de
comando help.search ()

3 Bt o
File Edt Code View Plots Session Buld Debug Tocks Help
gl-a- 8 & - | i - K Project: {None
0 Untitled1* -1 bvironment  Hintory —
Ed [ Souce on Save a2 #Run o Source = # B _t*ImportDetaset 5 List
1 help.searchi™Tinear model™ % Globsl Emviranment =
2
1 {TopLewel) 3 R Seript =
Consale 1
> help.search("linear model"™} files  Plots  Fackages Help  Viewer -
o 1 -~

= N
R Search Resuhs

Help pages:
agneglae resampbng model | Resamphng for inear models
4 ;

Simudation of the linear model under normality

agdsd aodm| ML Estimation of Generalized Linear Models for
Overdispersed Count Data

apdz-asdygl QUMM Estimation of Censralized Linaar Modals for
Pusrdienaread Caont Nata

12. Algumas fungdes e comandos basicos

Para visualizar o banco de dados
View ()

Limpar o console
Ctrl+L

Para ler as linhas de comando
Ctrl+Enter ou Ctrl+R

Mudanca de diretério
Ctrl+Shift+H:

getwd()
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Para visualizar os nomes dos arquivos que tem dentro da pasta escolhida para
trabalhar:

list.files()
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